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Introduction 
Welcome to Architectural Design (or the Apple lies. a flexible tool 
for easily creating floor plans, graphs. charts, architectural drawings, 
and morc. You can create your own floor plans, experiment with them, 
rearrange them, make printed copies. or use any of the more than 
2 dozen floor plans that you received with Architectural Design. 
Additional Design )'our 011'1) Home libraries are available. and each 
onc has more than 4 dozen predrawn plans. 

Architectural Design is an object-oriented drawing program. It dif· 
fers from paint programs in that things you draw, such as li nes and 
rectangles for example, are treated as objects that you can manipulate. 
You can quickly and easily change their color or size. move them 
around, rotate them. flip them horizontally or vertically, and much 
marc. 
You can also group objects to form more complex object units and 
save them for later use in other drawings (you can even group entire 
rooms and save them as custom objects for later use). Many com­
monly used architectural objects such a~ showers. washbowls, 
bathtubs, steps. doors, and others have already been created for you. 
You can add them to your drawing with a single keystroke. 

Here are just a few of the features thaI provide the power and fl exi­
bility you need to make creating floor plans (or any kind of drawing) 
a breeze: grid lines: grid snap; standard or user-defined scales; rulers 
which reflect real-world distances in the chosen scale; tools for drawing 
perfectly spaced joists or studs; dimension lines; text in various fonts , 
sizes, and styles; color blending, copying, and swapping; 48 custom 
patterns with pattern editing capability: predrawn architectural ob­
jects; support for custom objects you design. 

And as an additional bonus, a paint program is included on the pro­
gram disk you received. If you need to work on your drawing in ways 
that only a paint program can, you can save it a~ paint files and use 
Painl Your Own Home (see Chapter 5). 

Read on to see how quickly and easily you can: Design Your Own 
Home with Arcllitectural Design . 
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1 - Getting Started 
This part of the user's guide shows how to get Architectural Design 
up and running, gives you a hands-on int roduction to some of the 
tools. and explains how to get the most out of many powenul. yel 
easy to use features. 

If you are at all familiar with Apple's recommended standards for the 
mouse driven desktop environment, rou' ll feel right at home with Arch­
itectural Design's friendly human intenace. If you \'e never used the 
mouse or worked wilhin a desktop environment before. please study 
your Apple lies System /Jisk Uscr:~ Cuide. 
Note: Early relea~es of the Apple lies S),stem Disk U~er:~ Guide don'l 
have infonnalion about the desktop environment. Get a recent (spiral 
bound) version from an Apple dealer if yOu need one. 

Getting Ready 
Using The Mouse 
This section reviews some common tenllS related to using the mouse. 
These terms are lIsed frequently throughout this user's gu ide. 
Pointer refers to the sllmbol. shape, or character on the screen that 
mm'es when you mm'c your mouse. You'll see two basic t)'pes of 
pointers while usi ng An:hilectw,11 Desigll. the familiar arrow-shaped 
pointer and a cros.. .. -hair-shaped pointer used for drawing. They look 
like this: 

Often in this user's guide you are told to position the pointer and 
click. Click means to press and release the mouse button Quickly. 

Sometimes )'OU may be told to double-click. This means to quickly 
press and release the mouse button nvice. 

You'll also see the term drag. It means to press and hold the mouse 
button down. then move the mouse. 

Setting Your RAM disk 
Architectural DC81/11l requires 1024 K (I MBl of free memory to operate 
properly. so to ensure enough memory is free. go to the Control Panel 
and set your RAM disk size to zero before continuing (remember to 
turn your computer off (tnd back on again so the new settings will 
take effect). [f you need help. refer to "Appendix C"". "Setting Your 
RAf\'l Disk To Zero"'. 
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Write· Protecting Disks 
You can write-protect a disk to protect it from having data accidentally 
changed or destroyed. When a disk is write-protected, rOll cannot 
save drawings or any other kind of data on it. However, you can load 
drawings from il. or copy files from it to another disk. Before you 
use the Architectural Design program disk, be sure to write-prolect 
it. Read on through this section to find Dlll how. 

If you look at a 3.5/1 disk from the back side, you'll see a wrile-protect 
tab located near the top left corner. To write-protect a disk. use a 
pencil or appropriate item to slide the tab upward so that the small 
hole under the tab is uncO\'cred. You can slide the tab back down 
again to (o\'cr the hole if you want to save anything on the disk at 
a later time. 

You can use this technique to protect final data disks as well. 
Remember though, the disk cannot ha\'e information written to it 
until the write'protect has been disabled (i.e. you slide the tab to cover 
the hole), An error message is shown if you try to save anyth ing on 
a disk that is write-protected. so don't write-protect a working data 
disk that you']] need to save your designs on. Write-protecting a disk 
does not protect it against physical dam~e, like spilling a liquid on 
it. for example, so you should keep backup copies of your drawi ngs 
on other disks as lI'ell. 

Starting The Finder 
The Finder program is provided on the Design Your Own Home 
(OYOH) system disk. Among other things. th e Finder lets you start 
Architectural Design. make backups, initialize data disks, and copy 
disks or files. 

The first step to starting Architectural Design is to start the Finder. 
To do so. insert the OYOI-! system disk into your drive. turn off your 
computer (if it is on), wait for aboul30 seconds, and turn it back on 
again. 

Once the Finder screen appears. if you have one drive. remove the 
OYOH s)'Stem disk from your drive and insert the Architectural Design 
program disk. If you have two drives. insert the program disk into 
your second drive. A window with the name DYOH.Architect at the 
top of it opens automatically. 
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If fo r some reason the window does not appcar, you can open it 
yourself. To do so, use the mouse to move the arrow pointer onto 
the disk (or volume) icon that has the namc DYOH.Architect beneath 
it. then double-click the mouse button. 
The Architectural Design application icon is inside the OYOH.Ar­
chitect window (if ~'ou had to open the windo\\' yourself. you may 
need to use the \\'indow's scroll bars to find the icon), It has the name 
Architecture beneath it and looks [ike this: 

.a 
Rrchitecture 

Designs that you create and save to disk, and the pre-drawn designs 
included on the data disk, appear with a document icon when view­
ed from the Finder screen, The Architec/ural Design document icon 
looks like this: 

I t 
$oMple 

Note: The Finder will do much more than is covered in Ih is user's 
guide . Please refer to your Apple IICS System Disk User's Guide for 
detailed information about the finder. 
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Making A Backup 
Before you usc Architectural Design (or the fi rst time. read this sec· 
tion and make backup copies of the original disks that you reech'cd. 
Then put your originals in a safe place and use the backups fo r every­
day use. If you damage one of your backups. you can make another 
onc from the original. 

You need to use the Finder to make backups. If you haven't started 
the Finder. refer to the previous section and do so, then work through 
the following steps. 
1. If you ha\'c one drive. remove the Architectural Design program 

disk from your drive and insert a blank disk. Por two drives, remo\'e 
the DYOH.SVSTEM disk and insert the blank disk in il~ place. 

2. If the blank disk has never been used. you'll see a message asking 
if you want to initialize it, othenvise, the disk's icon and name ap­
pears on the desktop. Skip to 3 in that case. For an unused disk. 
type DYOH.Architect2 fo r its name and click Continue. Next, 
click ProDOS and 800k 2:1 to highlight the operating system 
and disk size you need. Then click Initialize to start the 
initialization. 

3. Once the initialization ha~ completed, move the pointer onto the 
original DYOH.Architect disk icon, press and hold down the 
mouse button, and drag the icon's outline onto the backup disk 
icon. Release the button. Read the confinnation message and click 
Ok. If you have one drive. follow the on-screen messages instruct­
ing you when to exchange disks. 

4. When the copy process finishes, drag your original disk icon to 
the trash can (that's on the screen, not in your kitchen) and remove 
the disk from the drive. 

5. Click on the icon of your backup disk to highlight (select) it. Its 
name is DYOH_Architect2 if you did step 2 above using a blank 
disk. Change the name by typi ng DYOH,Architect and pressing 
return . Don't USC a different name. This name is used by the Finder 
to associate documents with Architectural Design . Your backup 
copy is now ready to use (it doesn't hurl to write-prolect it like 
you did your original disk). 

Now that },ou\'c made a backup copy of your original program disk. 
make a backup copy of the DYOH.5YSTEI\1 disk and the Architec­
tural Design data (library) disk. F'ollow the same procedure as de­
scribed abo\'e to make the backups. However, use the s},stem disk's 
name (or data disk's name) and not the program disk name when 
you work through the above steps. 
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You should also create an 'ldditional data disk to store designs you 
want to save. To do so. insert a blank disk. type an appropriate name 
such as Arch,Oata. then click Continue and initialize the disk as 
described in step 2 above. Once initialized . it's ready for use. Please 
refer to your Apple IICS System Disk User s Guide for additional help 
in initializing and duplicating disks. 
Remember. backup copies arc only for your own safekeeping. It is 
not legal to distribute copies of this or any other software without 
written permission from the publisher. 

Starting Architectural Design 
If you haven't started the Finder or made backup copies of the disks 
you rece ived. work lhrough the preceding sections beginning with 
the "Cetting Ready" section before continuing. 

To start Architectural Design from the Finder screen. insert your 
backup copy of the progr'lm disk into your disk drive. Then move 
the pointer onto the Architecture application icon and double-dick. 
If you have trouble finding it. see the "Starting The Finder" section. 

You can also start Architectural Design from the Finder and have 
a drawing that you are working on automatically load for you. To 
do so. simply double-click on the document icon above the name of 
the drawing. Once Architectural Design loads .lIld starts, it will 
automatically open the drU\\'ing. See the "Starting The Finder" sec­
tion for an illustration of the document icon. 
Important: Read this if you started your computer from a disk other 
than the Design Your 011'11 Home system disk. ArchitcL"lural Design 
requires the 5.0 version of the CS system disk. If you start the Finder 
from a ROJ\l disk, Hard Disk. or any disk other than the DYOH system 
disk. be certai n you arc using CSOS before launchingArchitectura/ 
/)e_~ ig/l or it wi ll not operate properly. 
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The Architecture Desktop 
You can arrange thc whole desktop to suit )'our own needs. All the 
windOI\'S are mOllable. To mOI'e a window. move the pointer onto its 
(rame or background area. press and hold the mouse button to make 
an outline of lhe window appear. then drag the outline 10 a new loca­
tion. Release the button and the window moves 10 the new position. 
The document window has precedence ol'er other windows. If a win­
dow overlaps the document window. part or all of the o\'erlapping 
I\'indow rna}' disappear beneath Ihe document window. You may Ileed 
to mo\'C or re-size the document Il'indow to get to a hidden window. 

As indicated above. you can change the size of the document win· 
dow. Refer to the previous illustration. At the upper right corner. 
there is a small box called the zoom box. J\lo\'e onto it and dick to 
instantly enlarge the document window to fill most of the screen. A 
second click restores th e original window size. Use the box ilt th e 
lower right corner. referred to as a size box. to expand or shrink 
the document window to any size you want. To change the size. press 
and hold the mouse button. then drag the window outline inward or 
outward to the size you want and release the button . 

The box at the upper left corner is called iL close box and is described 
later. Don't usc it yet. 

Quitting 
When you want to Quit Archilcclufa/lJesigll. first sa\'e your design 
to disk (if you want a permanent COP}'). then selee! Quit from the 
File menu. After Architcctufa/I)e.~gn Quits. the Finder I\ill start ag.. ... in. 
See the "Menus" chapter for more about how to s<,\'e your designs. 

Trying Out Architectural Design 
Detailed descriptions of Arcllitcctur(1/ f)esign features arc given later. 
but for a brief introduction to some of them. read through and per· 
foml the (ollowing HANDS-ON exercises. Hefer to the previous screen 
illustration as needed throughout this section. 

Using The Selector Tool 
The Selector tool lets you select objects and change them. or move 
them to a new location. 

Begin by referring to the preceding screen illustration ilnd select the 
Hectangle tool. To select it. move the poi nter,onto it and click. 
Move into the drawing area. press and hold the mouse button while 
moving the mouse to drag and create a rectangle. Then do the same 
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to create a second rectangle so you' lI h,\\'c two rectangular objects 
that look similar to this: 

Exact locations and sizes aren't important here. The rectangles will 
only be used to explore some of Architectural Design's features. 
Now choose the Selector tool (click on it). Notice the last rectangle 
you drew has small squares at each corner. They are referred to as 
Handles and indicate an object is selected. Don't use them yet. Later 
you']] sce how you can use them to resize objects. Don't click anywhere 
in the drawing area or you may unselecl the rectangle and we need 
it selected for now, 

j\'love your pointer to the color palette and try cl icking on various 
colors and patterns. Notice how the interior of the selected rectangle 
changes to the color or pattern you select It's that simple to experi· 
ment with various color or pattern combinations in your drawings, 
Try holding the Apple key down when you d ick on a color or pat· 
tern. It lets you change an objects border color or pattern. 
Now click on the the transparent button (with the letters "Tm") by 
the top right side of the colors to show only the object's border (Lc. 
make it transparent). Click on any color or pattern to make the ob· 
ject solid again. 

You can changc the border width just as easily by clicking on dif· 
ferent sized lines in the Line Width window. Click on the widest line 
in the Line Width window. Notice that the size of the rectangle reo 
mains the same - only the width of its border changes. 

14 

To see how objeCl'i arc unselected. click on a blank. or unused. area 
of the drawi ng wi ndow (i.e. not on either rectangle). The rectangle's 
handles disappear. Selcct it again by mo\'ing onto it and clicking. 
To select both rectangles at once (or multiple objccts). hold the Apple 
key down and click on the second rectangle. Now click on a color 
and notice both objcct.~ take on the color. J\ny change you make (by 
clicking on colors. changing line thi ckness. or whatcver) affccts ALL 
sclccted objects. 
You can also select multiple objects with a dottcd rectangle referred 
to as a selection rectangle. To do so, movc thc pointer beyond the 
top lcft corner of of the objects to be selected - the blank screen area 
outside of any object. or in this case, outside of the two rectangles. 
Hold the mouse button down and drag the resulting dotted rectangle 
to the lower right corner of the objects to be selected. Release the 
bulton. All the objects that are wi thin the selection rectangle arc 
sclccted and will have handles. Click on any blank arca of the screen 
to ullscicci all selected objects. 
Anothcr fcature you'lI usc frcquently is selecting objects to move thcm 
to another location. You can movc a single object. or you can move 
many objects at once. To move both rectangles . select them both 
as describcd above. Then mO\'e onlo eithcr rectangle. Press and hold 
the mouse button and move the dotted outlinc of thc object.s to ,I 
ncll' location. Rclease the button. To movc a si nglc rcctangle. firs t 
click on a blank area to unselect both rectanglcs. Movc the pointer 
onto the rccl<lnglc you want to move (eilhcr will do). hold the button 
down and drag it.s dotted outline to a new position. Then release the 
bulton. 
You can pcrform many other operations on objects that arc selected. 
Th ey arc described in detail in other sections of this user's gu ide. 
In general. you can use items in the Edit, Adjust, and Text menus 
on selected objects. 

Using Grids And Rulers 
At start up. grid lincs arc invisible and lhe Snap To Grid feature is 
turned off. To see how this featu re works, first click on the close bo.\'.. 
the small box at thc top left corner of the drawing window, then click 
on the [No} button to crase your drawing window without saving the 
recl<mgles created in the previous scction. Now choose Snap To Grid 
from the Options menu. When this item has a check mark before 
it. it is enabled. Also choose Grid under Options and cl ick on the 
box beside "Show Crid". then click [Oklo 
Now draw two rectangles (refer 10 the previous section if you need 
help). Notice Ihat with Snap To Grid enabled. all coordinates when 
you begin to draw and as you drag snap to the nearest intersection 
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of the grid lines. This feature lets YOLI easil)! draw a series of objects 
the same size. or align edges. Y OLI can use Snap To Grid with or 
without visible grid lines. and you can change the spacing of the grid 
(see Grid in the Menus section). Because the screen redraws faste r 
without grid lines. you may want to usc tbem only when you are try­
ing to precisely size or align objects. It's your choice when to use them. 
Next, again under the Options menu. select Show Measurements. 
TI)' drawing a few more rectangles or use another drawing tool if you 
like (such as ovals or rounded rectangles). As you draw. notice that 
the size of the object is shown above the top ruler. These features 
are \'el)' useful for drawing plans to scale. They are described in detail 
under the appropriate menu items in the Menus chapter. 
This has been an introduction to only a few of Architectural Design 's 
fea tures. Many others remain to be tried. Go ahead and tl)' out other 
tools and don't be afraid to experiment. When you are ready, read 
on for a detailed description of all the tools. how to change and use 
colors. and about all of Architectural Designs features. 
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2 - Drawing Tools 
The drawing tools are located in the two windolfs at the left side of 
the screen. They look like this: 

5elecior 

Line 

Hollow Line 

Reclangle 

Rounded Reclangle 

Orawing Oval 
Tools Arc 
Window Polygon 

5kelch 

Stud Tool 

Dimension Line 

Text 

Line Widlh WjndOW ~ 

The large window contains tools which let rou choose the kind of 
object yOll want to draw. The small window below it lets you choose 
the width of lines or object's borders. To make a tool active. or select 
a line width. move the pointer onto it and click. 

Line Widths 
A check mark indicates the current working line width. Lines and 
objeclf borders are drawn with the current working width . 

Selector Tool 
The Selector tool lets you choose objects for mo\!ing, resizing. chang· 
ing colors. border Ividths, or many other operations described later 
in the Memls chapter. See the Trying Out Architectural Design sec· 
tion for a hands-on guide to using the Selector tool. 

Selecting Objects 
When the Selector is active, your pointer remains an arrow, even 
when it is over the drawing window. The pointer's hot spot, the part 
that is used todetennine what you have selected, is the tip of the arrow. 
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To select a larger solid object. mOI'e the aITOw onto it and dick. When 
choosing a small object among closely-spaced objects or lines. carefully 
place the tip of the arrow exactly on the object you want to select 
and cl ick. If an object is transparent. place the tip of the arrow on 
the object's border and click. 
Four small squares. called handles. appear at each corner of selected 
objects (lines ha\'e a handle at each end). If you are trying to select 
a small or transparent object and handles do not appear. reposition 
the tip of the arrow and tl'}' again. When selecting among closely­
spaced objects. if handles appear on an object other than the one 
you want. d ick on a blank area of the screen to clear the handles 
and tl'}' again. 
Note: In some situations. handles can cancel each other out. Handles 
are drawn by re\'ersing the colors on the screen under a gh'en handle. 
That way they can effecientiy and Quickly be erased b)' rel'ersing the 
colors a second time rather than by erasing the handles and redraw­
ing the objects. The only drawback is that occasionally t\\'o handles 
may occupy precisely the same location. In this case. when the second 
handle is drawn. it reverses the colors lhatwere alreadv reversed from 
drawing the first handle. This has the effect of erasing 'the first handle 
instead of drawing a second one. The object(s) are slill selected, and 
treated as such. el'en though one or more handles may not appear. 
This happens infrequentiy and if you watch dosely \\'hen it does. you'lI 
sec the handles flash briefly on the s(rcen indicating thcy ;:Ire actually 
being drawn. 
Hcre are some examples of selected objects: 

·0· 
• • 

YOl\ can hold the Apple key down and click on additional objects 
to make multiple selections. You can also select multiple objects with 
a dotted rectangle referred to as a selection rectangle. To do so, mo\'e 
the pointer to the top left side of the objects to be selected. Hold 
the mouse button down and drag the resulting dotted rectangle to 
the lower right comer of the object~ to be selected. Relea~e the button. 
If any portion of an object falls within the selection rectangle, it is 
selected. Click on any blank area of the screen to unselect al1 selected 
objects, or click on an object without holding the Apple key to select 
it and unselect all others. 
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Features that need at least one object selected in order to work will 
operate on all objects that are selected. For example. if two objects 
ilre selected and you dick on a color, both objects take on the color. 
In general. items from the Edit. Adjust, and Text menus operilte 
on selected objects. In fact. 1110st of the items in these menus remain 
disabled (dimmed) and unus<'\ble until one or 1110re objects hal'e been 
selected. Each item is described fully in the MClltls chapter. 

Moving Objects 
When the Selector tool is active, you can move objects by dragging 
them to a new location. To do so . move the pointer ol'er an object. 
then press and hold the mouse button. \Vhen a dotted outline or lhe 
object appears. move the outline to the new location of the object 
and release the button. 
You can mo\'e several objects al once b)' selecting all the objects you 
want to mOl'e, moving the pointer directly over alW one of them, and 
dragging the outline to a nell' location . All objects moved at the same 
time will remain in the same configuration relative to each other. 

Resizing Objects 
To resize a selected object. move the pointer onto one of its handles. 
Press and hold the mouse button, When a dotted outline of the ob­
ject appears. drag the object to a new size. For example. to enlarge 
a rectangle downward and to the right. use the handle on its bottom 
right corner and drag down and to the right to the desired size. 

l--I 
~o(ag 

Size an object back down by moving the dotted outline inward. Resize 
in other directions by dragging with a different handle. 

Select Undo at the left side of the colors window or under the Edit 
menu to reverse the last change made. Undo is described ful1 y in the 
Menus chapter. 
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Line Tools 
The Line ,md Hollow Line tools are for drawing straight lines. You 
can change a line's width by choosing a new width from the line palette 
below the tools. If the Selector is acti\'c. the line widths (and border 
widths) of selected objects also change. 

To change the LlUrking color for lines (the color used to draw the 
linc). hold down the Apple key and click on the color or pattern you 
want for the line. Do the same to set the border color for hollow lines. 
Click on a color to select the interior color for hollow lines (normall)' 
white). This method of selecting colors is used for other objects a<; 
well (sec a complete explanation in the Color Tools chapter). 

The Hollow Line 1001 is vcr)' useful for crealing windows in floor 
plans. however. it does not appear hollow unless the line size is <lI 
le.lst 3 dols high and the interior color is white or the line is 
transparent. 
To draw lines. move the pointer to the starting point of the line, press 
and hold the mouse button while moving the mouse to drag the line 
to the desired end point. then release the button. You can draw straight 
lines at perfect 45 or90 degree angles by pressing the Apple (or Shift) 
key before you begin the line. 

Rectangle, Rounded Rectangle, 
Oval, and Arc Tools 
As their names imply. you can use these tools to draw rectangles. 
rounded rectangles (rectangles with round corners), ci rcles or ovals. 
and arcs. You can change their border width by selecting a ne\\' line 
width below the drawing tools. You can change their border and fill 
colors or patterns the same \\'ar as described fo r lines above (see Color 
Tools for more). 

To use these tools, place the pointer where rou want one edge of 
lhe object to begin. Press and hold the mouse button , drag the ob· 
ject to the size and orientation you want (you can go any direction 
from the start point), then release the button. 

You can also make objects transparent (only their borders arc drawn) 
by clicking on the transparent button (with the letters "Trn") at the 
top right corner of the colors window. Click on any color or pattern 
to make objects solid again . 

:w 

To draw arcs (you would nonnally draw these transparent - see above 
for how), drag downward to draw the top part of a circle. and upward 
to draw the bottom part. For example. yOu can create the following 
arc by dragging do\\'n and to the right. 

To draw penect circles with the oval tool, squares with the rectangle 
tool, or 90 degree arcs with the arc tool. press the Apple (or Shift) 
key before you begin to draw. 

Polygon Tool 
Use this tool to create a polygon, or many-sided, object. To draw a 
polygon, move the pointer to il,; start point and click. l'o10ve to the 
fi rst line's end point (and next line's start) and click again. Continue 
this sequence until you've completed the object by ending at your 
original start point, or double click (click twice rapidM anywhere to 
end and h.we the last polygolllinc .1utomaticallJI completed (or you. 
As with most other objects. you can change a polygon·s border width 
or make it transparent. 

The following arc all examples of polygons: 

Sketch Tool 
This is a flexible drawing lool used to create irregularly-shaped ob­
jects or regions. Here are some examples: 
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To sketch. move the pointer to the start position. press and hold the 
mouse button. and move the mouse. Release the button to stop. 
Remember, this tool still creates an object enlit)' so it's desirable to 
end the sketch where you begin (as with polygons). If you release the 
button elsewhere. the object is completed for you with a straight line 
back to the start. 
If you don't want a border on your sketched object (or any object). 
simply set the border color to the same color or pattern as the interior 
color; by holding the Apple key down and clicking on the color or 
pattern you want for the border. 
Keep in mind that a good deal of memory is required to maintain 
a sketched object. All its points must be remembered and redrawn 
when the object is moved. or if it needs to be redrawn for any reason. 
This can drastically slow the process of refreshing the drawing window. 
It is wise to use this tool only when really needed. and to use the other 
drawing tools instead when they are appropriate. When you need to 
sketch. complete the bulk of your drawing tirst and draw the sketched 
areas last so you aren't burdened with slow window refreshes fo r your 
entire drawing job. Also. the smaller the sketches, the better. If the 
Polygon tool will work. use it Though not as fast as objects like SQuares 
and circles. polygon objects still redraw much faster than sketched 
objects. 

Stud Tool 
This tool is a time-saver when drawing a series of rectangular shapes 
such as studs. The final product is treated as one object. not a series 
of separate objects. 
To use the Stud tool. select a start location and drag a rectangle to 
enclose an area you want to fill with studs. You could also use this 
tool for other situations where rou need a series of rectangular objects. 
The Stud tool is an aid for doing lumber estimates too. Once you 
have dra\'.'Tl the studs. click on the Selector tool and choose Info under 
the Edit menu to sec how many boards were used. how much material 
you' lI need to co\'er them, and to get other useful measurements. 

Selecting Stud Tool from the Options allows you to change a series 
of parameters about the studs: the spacing, board size. view point 
or orientation. Refer to Stud Tool in the Options menu section of 
Chapter 4 for a detailed descriptlon of the parameters and how to 
change them. 
Because studs are more complex to draw, the program will take slightly 
longer to draw or redraw them. For this reason. you may prefer to 
draw studs after your drawing is mostly finished. 
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Dimension Line Tool 
This tool lets you Quickly and easily add dimension lines. with arrows 
and measurements, to your drawing. Drawa dimension line the same 
as you would a normal line. Just selecl the start point. press and hold 
the mouse button, drag the li ne to the desired end point. and release 
the bulton. You'll see the line break in the center with the dimen­
sion listed. 
Dimension lines arc more complex objects and the program will take 
slightly longer to draw and redraw them. You may want to wait and 
usc them ncar the completion of rourdrawing so screen redraws are 
faster for the bulk of your drawing project. 
The line width of dimension lines cannot be changed. howe\'er. you 
can change their color like any other line. by holding down the Apple 
key while you click on a color. 

Text Tool 
Use this tool to add text or labels to your drawing. Move the pointer 
to the spot you want to begin typing and click the mouse button. You'll 
see a flashing bar cursor appear. Co to the keyboard and type your 
text. Press the delete kcy if you make a mistake. When you have fin­
ished typing. you can simply select a different tool. The text you typed 
will be comcrtcd al~d kept as a single object. 
If you want to continue typing but in a different location. use the mouse 
to select the new location and click. The last text you typed is kept 
as an object and you can begin typing a new text object as before. 
You can press the ncturn key to cnd a line of text and start a new 
line below thc prcvious line. 
Select Choose Font from the Text mcnu to sct the size. style. or 
type of font you want for your text. You can make size. style, or font 
changes to cxisting text by sclecting it (with the Selector tool). then 
using the Choose Font item and making the desired changes. See 
the Choose Font in Chapter 4 for a complete description. 
Change the color of text by clicking on a color at any time wh ile typ­
ing or before you begin typing. and for existing text, change the color 
by selecting the text (with the Selector tool) and clicking on a color. 
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3 - Color Tools 
The color tools are located near the bottom of the screen and look 
like this: 

Undo Anything Duplicate Color 
Blend Color 

LI ______ cOlor Tools Wlndow'------_-J 

Each item in the color tools window is described in the following sec­
tions. Please refer back to this illustration as needed. 

Selecting Colors 
The current color (or pattern) selected (or drawing is referred to as 
the working color. The currently selected working color is shown at 
the left end of the color palette. 

To change the working color, click the desired palette color or pat­
tem. If the Selector is active, the color of selected objects change a1so. 
When drawing occurs, unless objects arc transparent, the working 
color is used to fill objects' interiors. To change the border color of 
objects. press the Apple key before you click on a color or pattern. 
The current working color is framed by the current border color in 
the rectangle at the left side of the color palette. The lines in the Line 
Width window are also drawn with the working border color. 

Make the border color the same as the working color to create ob· 
jects without contrasting borders. 

Selecting Patterns 
Patterns are selected and used the same as an)' color. The)' can be 
used for object borders or fi ll colors. There are 48 patterns available 
at anyone time, and more can be created. saved to disk, and loaded 
as needed. See the Menus chapter to learn how. 

Sixteen patterns are shown in the color tools window. Click on the 
working color block at the left side of the patterns to cycle through 
the next sixteen patterns. 
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Undo Button 
An Undo button was placed in the color tools window for Quick. easy 
access. This Undo works in exactly the same way iL'; the Undo under 
the Edit menu. Use it to reverse the I,\st change made to colors or 
your drawing. In most instances you can cl ick it again to Undo the 
Undo also. or toggle between the ];L~t change made and the state before 
the change was made. When Undo is not ,wailable. it is dimmed. 
All other buttons in the color tools window relate to colors only. 

Dupe, Swap, And Blend Buttons 
You can use the three buttons. Dupe, Swap, and Blend , in the col· 
or tools \rindow to change or arrange palette colors. Click on a but· 
ton to highlight it (l ighten its color) and activate it fo r use. 
Note: The two colors on each end of the palette (black. dark grey. 
light grey. and white) are reserved to maintain the integrity of th e 
screen display and windows. They are included in the palette so you 
can use them in your drawing: howevcr. if you try to change them. 
you'll hear a beep. and they will not change. 

Dupe 
Dupe (duplicate) lel<; you cop)' one palette color ol"er ,mother. To 
duplicate a color: cl ick on Dupe. mO\'e the pointer onto the color 
)'ou want to duplicate. press and hold down the mouse button. then 
slide the color's outline to the location where you want a duplicate 
and releiL<;c the button. Objecl<; on the scrcen which were the destina· 
tion color become the new color. Click on Undo to rel"erse the chan/.!e. 
You milY duplicate one of the four reserved end colors (sec the above 
notelto another unfcser.'ed square. but )'OU may not move a color 
onto an~' of the four reserved end colors. 

Swap 
Usc Swap to exchange the position of \1\'0 colors without altering 
either color. Each color is mol'( . .od to the other's position in the palette. 
Th is causes objecl<; all the screen which are drawn with the colors 
to have their colors swapped also. 
To Swap colors: click on Swap. mOl'e the pointer onto one of the 
colors. press and hold the mouse button. then slide the color's outline 
over the color )'ou want to Swap it with and release the mouse but­
ton. You can click on Undo to rel"erse th e Swap. The four reserved 
end colors may not be involved in a Swap. 
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Blend 
Blend is a feature that lets you crcate a series of intermediate colors 
between two target colors (how is explained a little later), All the colors 
between two target colors gradually blend from the first target color 
into the second target color. For example, if rou choose the dark 
grc)' on the left side of the palette as the first target color and the 
light grey on the right side as your second target color, all the palette 
colors between them will turn to gradient shades of grey. Again. the 
two resen'cd colors on each end of the palette rna)' not be changed 
by a blend, although a blend may include dark or light grey for a total 
of 14 squares that can be involved in a blend, and 12 that can be 
changed by a blend. 

You can use Dupe or Swap to position target colors in the palette 
before blend ing. For example, you might move red (with Dupe) next 
to the dark grey color and place white four squares to its right. then 
blend between the two for varying shades of red. Then you might 
move green next to the last white target color. and put brown 4 squares 
to its righ t, then blend between them creating 2 separate blends in 
the palette. 

To get the ma.ximum number of intermediate colors from a blend. 
use Dupe or Swap to mo\'e the target colors to each end of the 12 
changeable color squares, then blend between the two target colors. 
f'.1any marc variations are possible. Co ahead and experi ment. You 
can always Undo the last change made, or restore the standard col· 
ors by selecting Default Colors under the Options menu. Remember 
that objects on the screen (and pattems) that were any of the original 
colors will take on the Blend changes also. 

To do a Blend: click on Blend, mO\'e onto either one of the two target 
colors that you want to blend between. press and hold the mouse 
button, slide the color's outline to the second target color. and release 
the button. Again. you can do repeated Blends. and use Dupe or Swap 
to arrange the color palette as desired . 
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Changing Palette Colors Via Mix 
To change the amount of Red. Green. or Blue (RGB) in a palette 
color. click on the foiix button at the right end of the color tools 
window. 

A window will appear with 3 scroll bars. Click on one of the colors 
in the palette to choose a working color. This working color will be 
shown below the scroll bars. Use the scroll bars 10 change the color's 
RCB Mix. or level. Each Red, Green. or Blue level can range from 
010 15 for a total of 4096 possible colors. Click on the sc roll bar 
arrows to change the mix slowly. one level per click. As the chosen 
working color changes. you'lI see the same color on the palette change. 
and also any objects on the screen that are the working color will 
change. 

You can click on anothcr palctte color to make it thc working color 
and change it. or when you're finished changing colors. click on the 
J't'lix window close box (or anywherc on the drawing window) to remove 
the Mix window. 

Making Objects Transparent 
The remaining color tool lets you draw transparent objects. 
Transparent objects consist of borders without any interior fill color. 
You can see through. transparent objects - objects underneath them 
are visible. 

To draw transparcnt objects. mo\'C thc pointer onto the transparent 
button at the righ t side of the color palette and click. The button 
has the letters "Trn" on it. Now objects }'ou draw will be transparent. 
Click on a pattern or color to draw solid objects again. 
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4, - Menus 
This chapter describes the pull-down menus along the top of the 
screen. To pull a menu down, place the arrow pointer on top of its 
title, then press and hold the mouse button down. A list of menu 
choices will appear beneath the menu ti tle. To select 11 menu item. 
continue to hold the mouse button down. then mo\'e the mouse 
downward. ~1enu choices are highlighted as the pointer passes over 
them. Release the mouse button to select the highlighted menu item. 
l' .. lenu items that cannot currently be selected arc dimmed and will 
not highlight. 
f.1any frequently-used menu items can be accessed quickly using the 
keyboard. It'lenu items that can be accessed with the keyboard are 
indicated with an Apple symbol and a keyboard character. Here are 
some examples: 

6Z 
Cut 6X 
Copy 6C 
Past@ 6V 
Cl@'or 
Select All 6R 
Lock 6L 
Unlock 6U 
Group 6G 
Ungroup 6H 
Info 61 

To make a menu selection from the keyboard. press the Apple kc}' 
along with the appropriate keyboard character. In the above illustra­
tion. if you wanted to choose Select All . you would press IApple-AI. 
which means, hold down the Apple key and press the leiter "A", The 
.. - " character inside the brackets is only used as a separater. A 
keyboard selection is performed just as if yOu had Dulled-down the 
menu and made the selection with the mouse. You do not need to 
press the shift key if the character is on the upper part of a key. For 
example, press only [Apple-:] for the" : .. character. 
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Apple Menu 
The Apple menu (the Apple symbol at the upper left comer) con­
tains an About item and the names of Desk Accessories you can use. 

About 
This choice shows informalion about Architectural Design such as 
the copyright date. the company that published it. and the pro­
grammer's name. 

Status 
Select this item to see information about your current drawing and 
the system. such as how much memo!), is free and used. what the 
size of your drawing is. its scale. and so on. 

Desk Accessories 
Desk Accessories are normally short programs you can choose that 
do some specific task (like a clock, calculator. simple game, or puzzle). 
A list of available Desk Accessories are added to the Apple menu. 
Choose them like any other menu item. 

The choices you have depend on what Desk Accessories are in the 
SYSTEt'o·IIDES K.ACCSI folder of the disk you used to start-up your 
computer. 
On the 5.0 and late; versions of the CS system disk. Apple supplies 
a Control Panel desk accessory. You can use it to change your Con­
trol Panel's settings (see "Appendix B" for help setling it for print­
ing). Contact your local dealer to learn more about it. or to get the 
latest system disk and user's guide. 

File Menu 
New 
Select New when you want to crase your current drawing and make 
a fresh start. The drawing window is erased and its name is changed 
to "Untitled". Before erasing, you are given the opportunity to save 
changes (sec Save below) or cancel. 

Open 
Open displays a catalog of the current drive and lets you load an ex­
isting drawing. You are given the chance to save your current draw­
ing if changes have been made (see Save) . 
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Notc: If a drawing has tcxt objects. Architectural Design tries to usc 
the same fo nts they ..... ere originally created with. The same fonts must 
be available in the /SYSTEM/FONTS/ fo lder of your boot disk so the 
Font t-1anager can load and install them. If the Font t-1anager can­
not load the desired fonl. the nearest matching font is used instead. 

Close 
Close crases the drawing window and sets the name for the new draw­
ing to "Untitled". Close and New are implemented identically byArch­
itectural Design. Both are included for completeness. As al ..... ays. you'll 
have a chance to Silve your current drawing if changes have been made 
since the last save. 

You can also select the Close Box at the uppcr left comer of the draw­
ing window. 

To end your editing session. use Quit rather than Close. 

Save 
Choose Save to save a copy of your drawing to disk. If your drawing 
is "Untitlcd", a dialog appears so you can name it. You should give 
your drawing a unique name and notsavc it with "Untitled" as its name. 
If your drawing is already named because you have sa\'ed it during 
the current session, or because you loaded it (with Open) from a libran' 
or othcr data disk, you are not prompted for a new name. The cur­
rent name is used and the save is performed immediately. This lets 
)'ou quickly save an updated version of your drawing to a data disk. 
Warning: Any previous \'ersion of your drawing with the same name 
will automatically be replaced with your current drawing when you 
use Save. The program assumes you intentionally want to update the 
previous version on your data disk and does not remind you of this 
fact. To protect a previous version, use Save As (sec below) to give 
your current drawing a different name, 

Use Save frequently while you are drawing so you'll always have a 
recent backup of your drawing stored safely on disk. To do a sa\'e 
quickly, hold down the Apple key while )'ou press IS]. Be sure to lea\'e 
your work disk in the drive so Architectur<11 Design can save your 
drawing successfully. 

Frequent saves provide added protection in case a power failure oc­
curs or your computer quits worki ng for any reason . If you update 
your disk version often, you'll lose only a few recent changes and not 
your entire drawing or hours of work. 
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Save As 
Use Save As to save your drawi ng under a different name. or to save 
it to a different disk or directOl)' folder. After the 5<1\'e. the name above 
the drawing \\'indow is changed to your drawing's new name. Any future 
saves with Save (above) are performed using the new name. 

YOll can use Save As to save a copy of important drawings on more 
than one disk for added protection in case one disk is inadvertently 
damaged. 

Revert 
This reloads the last version of your drawing that was saved to disk. 
You can usc Re\'ert if you've made changes since last savi ng your 
drawing and decide you don't want them. This choice remai ns dim 
and lInseleclable until you make changes to a drawing after using 
Open or Save. 

Scan 
Scan lets you look at the drawings in a disk's directory. Select Scan, 
then Open any drawing in the specific directory you want to Scan 
by double-clicking on the drawing's name, or click on its name and 
on the Open bullon. When you open a file, it lets Architectural Design 
know which direct01), you want to Scan. 
All the drJ\\Tings in' the directory are shown sequentially. The fi rst 
drawing you see may not be the one you opened. but it witl appear 
before the Scan is finished. 
The name of the currently scanned drawing is shown at the bottom 
of the screen. When you are ready to continue. click [Previous] to 
see the drawing you saw prior to the current drawing, or [Next] for 
the drawing following the current one. or click [Quit] to cancel the 
Scan. You can also press the [Esc] key to cancel. If you go beyond 
the start or end of the directory, the Scan continues from the op­
posite end. 

Overlay 
Choose Overlay to load a drawing, wiring, or plumbing diagram from 
disk and display it over the top of your current drawing. You could 
also use this feature to merge or append two or more drawings. If 
you decide you don 't want to keep the overlay, click Undo. 
Here's an example of how to create a wiring diagram overlay for a 
floo r plan. First, be sure you have a permanent copy of your floor 
plan saved to disk because this procedure will altcr it. Then click on 
the Selector tool and choose Select AU from the Edit menu (or press 
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IApple-A]). Handles will appear around each object. Now choose 
Group under the Edit menu to make a single group of all the parts 
of the floor plan. The handles around each object will disappear and 
one handle will appear at each corner of your drawing. Now the pro­
gram will treat your whole drawing as one object. 

Draw your wiring diagram right over the top of the 1100r plan. When 
the wiring diagram is finished, click on the Selector and move the 
pointer onto any object that's part of your original grouped floor plan 
and cl ick to select it. Your original floor plan should be selected (in­
dicated by a handle at each corner) , and the objects in your wiring 
diagram should NOT be selected. If you see any object that's part 
of your wiring diagram selected, click on a blank area of the screen 
to unselect everything and try again. 
Now press the Delete key to erase your 1100r plan leaving only the 
wiring diagram. If any part of your wiring diagram disappears, you 
can click [Undol and try once more to select and delete only the 1100r 
plan. Once the floor plan is deleted. you can save your wiring diagram 
to disk with Save As. Be sure to save it with a name different than 
the one you gave to your original drawing (eg. house. wiring). 
With your wiring diagram separate from your floor plan, you can view 
each individually, view them together, or view them with other overlays, 
like plumbing. Use Overlay to place one design over another. 

Save Paint Files 
To save your drawing as standard unpacked Apple lIes paint files 
(file type SCI) that can be loaded by most popular paint programs, 
and by the Paint Your Own Home program included with Architec­
tural Design, choose Save Paint Files . 

Since a paint screen is about half the size of a drawing page, each 
page of your drawing saves as 2 paint files. Each file requires about 
33k of disk space, so be sure you have enough free disk space before 
you try to save a large drawing. Sequential numbering is automatically 
appended to the filename you type to make unique filenames for all 
the files (e.g. MyPaint.l, MyPaint.2 , etc.) . After you have saved your 
drawing as paint files, you can select Quit to return to the Finder 
then launch Paint Your Own Home to work with the paint files. 

You cannot reload drawings that are saved as paint files so if you want 
to load (Open) your drawing again later with Architectural Design, 
be sure to also save it the normal way with Save or Save As. Paint 
programs use bit-mapped pictures, not objects you can select. move. 
or change as with Architectural Design. 
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Delete 
Use this to delete files that you don't want on a disk. To delete a file, 
click on its name. then click on [Open]. If the name is correct. click 
on [O~J to perform the delete. or click on [Cancel] to reUst the files 
for another selection. 

You can continue deleting files, or click on ]Cancel]. rather than on 
a file 's name. 10 quit. 

Note: Delete lets you delete only files. If you open a folder, it's opened 
so you can see the files within it. A folder cannot be deleted. If th e 
folder is empty, no files are listed . Click on IClose) to exit the folder. 
To delete a folder, use the system utilites on your system disk. or 
the PINDER, 

Choose Pr inter 
If you are using the latest system software (as you should be), you 
can now use the Control Panel desk accessory under the Apple menu 
to let Architectural Design (and the system software) know the type 
of printer you have, and how it's connected to your computer. If you 
use the Control Panel desk accessory, you do not need to select 
Choose Printer . For help setting the Control Panel. see "Appendix 
B", 

If you arc using an earlier version of the CSOS system disk (earlier 
than 4.0 will not work properly with Architectural Design), you need 
to select Choose Printer. Afterward, you 'll see this dialog. 

AppleTalk. Select this as your printer port if you are using a 
LaserWriter. 

Direct Connect_ Choose this option if your printer is connected 
directly to your computer. 
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User Name. Type your user name if you are usi ng AppleTalk. 

Click the printer and port you are using then click Ok to use the 
new settings, or click Cancel to retain your original settings. 

Page Setup 
Use Page Setup to set the paper size and way you want your image 
printed. This is optional. Standard settings are used if you don't change 
them. 

The ImageWriter Page Setup dialog looks like this: 

. @Ull'tt" 
OUll,gal 
o A~ lflt" 
o lntornational fanfold 

V!rticai Sizing: 
@Horm,l 
o Cand!nl,d 

Orifntat ion: 
~~ 

Print" Eft"t" 
o SOt Roduction 
o H, GoP' B,t.". 

Pag" 

(Cancol)eD 

US Letter. This is the default paper setting. It's for paper that's 8 1h 
by 11 inches. 

US Legal. Use this option for paper that's 81h by 14 inches. 

A4 Letter. This option is for European standard paper. Its size is 
8-114 by 11 ·213 inches (210 by 297 mm). 

International Fanfold. This option is (or the Image\Vriteronly. It's 
the International standard size of 8-114 by 12 inches (210 mm by 12 
inches). 

85 Letter. This option is for the LaserWriteronly (see the next dialog 
illus.). Its paper size is 15 by 11 inches (250 by 176 mm). 

Normal. This setting prints drawings with the same proportions they 
have on the screen. 

Intermediate. Intermediate prints drawings approximately two thirds 
their normal size (for the LaserWriter only). 
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Condensed. Drawings printed with this option are about half thei r 
normal height. This option causes dra\\'ing width I height ratios to 
distort , so donl use this option unless you ha\'e a special need fo r 
that effect. 
50% Reduction. Drawings are printed at half their normal width 
and height. 
No Gaps Between Pages. Printing is continuous without page breaks 
when this option is selected. 
Portrait. Drawings are printed with the same upright orientation they 
ha\'e on the screen. 
Landscape. Select this option to print sideways (turned righ l 90 
degrees). 
Here is the LaserWriter dialog followed by options that differ from 
the abo\'e descriptions: 

lRS,RWRITIR/RPPlETilK vl.l 

Paper: @ USl~tter 0 R4l@tter 
OUstP9al OSSLttter 

Orientation: Verti cal Sizing: 

~ 
@Horlla) 

., . 0 Intermediate 
OCondensed 

Printer Effects: Red uce or rrr.r.i1 
181 Smoothing? [nlarge: ~l 
[8:1 rant Substitution? __ 

~. 

Printer Effects. These LaserWriler options are (or bit mapped fonts. 

Reduce or Enlarge. You can type a number from 25 to 200 to reduce 
or enlarge your printout. A value of 100 is normal size (100% of im· 
age), 200 enlarges a drawing to twice its size (100% X 2 - 200%). 
and 50 reduces a drawing to half its normal size (100% 12 - 50%). 

Print 
Select this to set the number of copies you want to print, whether 
to print in color, and to print a drawing. Before you print, be sure 
to usc the Control Panel desk accessor)' or Choose Printer. Other­
wise, your computer may hang-up (see the "Choose Printer" section 
and "Appendix B" for more). 
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This is the dialog you'll see for the ImageWriter: 

I HAGElIR lTERiPR I iTER v1.2 
Quolity: 0 Blttor leXl 

@BoII .. Color 
o DroIt 

Pag, rang.: 
@All 

Of roo: 0 To: 0 
Cogies: [[] 
Pager feed:@Auto.oticOHonual 

DCoior ( Con"l) CEJ 
Better Text. This option doubles the printer resolution. It produces 
the best Quality text and lines. However, fel\'er colors are available. 
Use this option when the quality of lines, black and white patterns. 
and text is more important than a Ivide range of colors. 

Better Color. f.10re color and better shades of gre)' are produced 
with this option, but the printer resolution is lower (than better text. 
above) so lines are more coarse and text may not be readable. 

Draft. Don't use this option. Its used for dumping text straight to 
the printer and doesn't work for graphic drawings. 

Page Range. This option is ignored. An entire drawing is always 
printed. 

Copies. Type the number of copies you want to print. The computer 
automatically moves the printer's paper to the next page and prints 
each copy (if the Paper Feed is set to Automatic - see below). 

Automatic. Used for continuous paper. The computer advances the 
printer's paper and continues to print if you are printing multiple 
copies. 

Manual. If printing multiple copies, you are prompted before each 
copy, and can continue to print or stop. 

Color. If you hal'e an ImageWriter II and a color ribbon , you can 
select this option to print images in color. An ImageWriter I can't 
print in color, so you shouldn't use this option with an ImageWriter I. 
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Here is the print dialog you'll sec for the LaserWriter. 

LASERWR lTE RiAPPlETRLK vl.O 

P09": @ All 

o from: D To: D 
Cogi":[[] 
Poger Source: 

@Pager Cassette 
o Honual fe ed 

(Cancel )m 
Pages. As with Page I?ange for the ImagcWriter. this option is not 
used. 

Copies. T}'I)e the number of copies you want to print. If YOll need 
to. use the Itabl ke}' to move to the copies' box to type a number 
(or click on the box). 

Paper Tray. You (an usc this option if you hal'c ,I paper tray. 

Ma nu al Feed. Usc this option for fccuing single sheets of paper by 
hand. 

To Star t Pr inting. Once rOll hal'<: all the Print dialog options sci 
as desired. click on the [Okl button to start printing. Hemember to 
make sure yoUI' printer is on and rCi.ldy for printing. )'ou c.1n press 
{Apple·period} to stop printing iiI progress, or when a drall'ing 
has completely printed. press {Apple-period} to s.wc time .1ml 
al'oid waits (or the printing sequence to eml. 

Be sure your computer's Control Panel settings arc set to the right 
slots for your printer or your computer may hi.lng up when you try 
to print. 

If you decide not to print. click on the [Ci.I1lCelj button. 

Note for LaserWriter users: Horizontal scale adjustments must be 
made when printing to a L,l~erWriter to make dri.lwings print to scale 
correctly. For this reason . approximately one half inch is lost on the 
right side of the drawing page. If your drawing extends all the way 
to the right side of the dri.lwing window. and you need to do a Laser­
Writer printout. you can choose Select All and mOl'e the whole draw­
ing slightly to the left. 

37 



Quit 
When you are completely finished using Architectural Design, select 
Quit. You are given the chance to save recent changes before quitting. 

Edit Menu 
All the choices under Edit work with objects that have been selected 
with the Selector tool. Before using one of the menu items discussed 
here. }'OU must select one or more objects. 

To select an object, click on the Selector tool to activate it (it's the 
arro\v at the top of the tools window), then mo\'e onto an object and 
click to select it. Press the [Apple] key before clicking to select more 
than one object at once. 
Por additional help selecting objects, do the Trying Out Architec­
tural Design section in chapter 1. and sec Selecting Objects in 
chapter 2, Drawing Tools. 

Undo 
This works the same as the Undo button in the color tools window. 
You can use it to reverse the last change made to your drawing or 
color palette. In most instances you can select it again and Undo the 
Undo (restore and keep the last change you made prior to selecting 
Undo). 

Cut 
Cut remo\'es selected objects (selected with the Selector tool) from 
your drawing and places them in a clipboard fil e. The current direc­
tory of the disk you used last is used for the clipboard fi le. Any ob­
jects \."hich were already in the clipboard fi le are replaced. 

Be sure the disk is ready and in the drive or the Cut will be unsuc­
cessful and an error will be reported. If you change your mi nd and 
want to restore your objects, click [U ndol. 
You can Paste the objects back into your current drawing. or Open 
a different drawing and Paste them into it (see Paste). 

Copy 
Use Copy to store a copy of selected objects into the clipboard file . 
Your drawing is not changed. The objects you copy replace any ob­
jects already in the clipboard fi le. 
You can Paste the objects back into your current dr3l\'ing or another 
drawing at a later time (see below) . 
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Paste 
Choose Paste to copy al1 1he objects from the clipboard fi le (on the 
disk you used last) inlo your drawing. The objects are automatically 
selected, and the Selector tool is acth'ated so you can easily move 
the pasted objects where you want them. Click IUndo] to rcmO\'c pasted 
objects. 

Clear 
You can use Clear to remo\'e objects from your design. In this case. 
the objects are not placed in the clipboard. If you change your mind 
and want to restore your objects, click IUndo[. You must click on 
objects to select them beCore you choose Clear . 

Select All 
When the Selector tool is active, choose Select All or press [Apple­
AI to Quickly select every object in your drawing. You might want 
to do th is to change the border color. \\'orking color. or line width 
for all objects. or to mo\'e all objects at once. 

Lock 
First select one or more objects. then select Lock to keep them from 
being mo\'ed or changed. Locked objects cannot be moved. grouped. 
deleted. or changed in any way (except with New or Close for start­
ing a new drawing). 
Objects that are locked have a small key-like s)'mbol above their top 
left handle when they are selected. The only editing operation that 
will have an effect on locked objects is Unlock. 
This feature can be Quite useful. For example. you may want to lock 
floor plan walls and other objects so you can arrange objects nearby 
without accidently changing the objects you don't want changed. 

Unlock 
First select one or more locked objecl<i. then choose Unlock to unlock 
them. 

Group 
This converts a collection of selected objects (objects that have been 
selected with the Selector tool) into a single grouped unit. You must 
have more than one object selected before you can use Group. For 
help selecting objects, see Using The Selector Tool in the Trying 
Out Architectural Design section of chapter 1. and also Selecting 
Objects in chapter 2. 
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The objects' screen (Oordinates and SiZl'S ,Ire not changed by grouping 
them. Once grouped. thc objects arc treatcd as a single object until 
they arc ungrouped. This means if you selec t a grouped object. then 
click on a color. all the individu<tl objects withing the group take on 
the color. You can usc Ungroup (below) to separate grouped objects 
and make a change to a single object within a group. then regroup 
thelll again afterwards. 

Ungroup 
You can select one or more grouped objecl~ and choose Ungroup 
to seperate \hem into thei r individual component objects. 

Info 
Choose this to display information about a selected object. The type 
of information varies according to the type of object but always in· 
eludes its measurel1lenl~ (size). Use IlI lers and mea~urcmenls for other 
size information (sec ShowlHide nu ler s and ShowlHide 
1\leasurements under Opt ions). 

Adjust Menu 
i\11 the choices under Adjust work with objecl~ that have been selected 
with the Selector tool. Work through the Trying Out Architectural 
Design section of chapter I ami see Select ing Objects in chapter 
2 if you Ileed hel p selecti ng objects. 

Move To Top/Bottom 
These two choices let you rearrange the stacking order of selected 
objects. You can select an object ami place it benealh (or behind) 
another object with !\love To Bottom, or move a selected object in 
frOllt of another object with !\Io\'e To Top. 

Align With Grid 
If the Snap To Grid feature is enabled (see Options 1\lenu), you can 
choose Align With Grid to align selected objects with the grid using 
the coordinates of their upper left corner. 

Th is feature is useful if you draw objects with the grid snap feature 
turned off and later decide you want them aligned. or for any situa­
tion where objects arc nol aligned wi th the grid . 

Rotate Left/Right 
Use these menu items to rotate selecteci objects left or right 90 degrees. 

Flip HorizontallVertical 
Choose these items to flip the orientation of select!.-d objects fro m 
left to right (horizontally) or top to bottom (\'ertically). 

Text Menu 
Choose Font 
Use Choose Font to pick the font you want for typing text with the 
Text tool. You can also set the font' s size and style. 

The changes you make are used the next time you type usi ng the 
Text tool. If the Selector tool is active and )'ou've selected one or 
more text objects, the selected text also takes on the changes. This 
lets you change the size. slyle, or font of existing text. 

After you select Choose Font, the following dialog appears: 

Font: 
Courier r Geneva 
Helvetica 

, , 
Times ~ Venice 

Stule: Size: Other 
t8J Plain 

OJ 
Size: 

DSold rn::::::J o Italic 
(Cancel) o Underline o Outline (I n o Shadow OK 

Font. When Architectural Design begins. the fonl for the Text tool 
is defau lted to the system font. The default system font is called 
"Shaston". Remember its name in case you want to use it again after 
you ha\'e changed fonts. Its default size is 8, and its default style is Plain. 

To choose a font, click on its name. The chosen fonl is highlighted 
(darkened). If you need to, use the scroll bar arrows to scroll the list 
of font names. 

Note: The fonts you can choose from are in the ISYSTE1\1WONTSI 
folder of the disk that you started-up your computer with. These names 
are listed in the Choose Font dialog. 

41 



Style. A fonfs style refers to the way a font looks. Style choices include 
Plain, Bold, Italic, Underline, Outline, and Shadow. Herc·s how 
they look: 

Pla i n 
Bold 

Italic 
Underline 

(Dml3!l[\[il@ 
01ll(!Jca~ 

You can usc all the styles at once except Plain. which cancels all other 
styles (it's plain). Also. Underline is not supported for the system font, 
Shaston. 

To select a style, click the box next to its name. A second click 
unselects it. 
Size. To select or change the size of a font. click on a number in 
the Size catalog (the larger the number, the bigger the text), or type 
a number in the Other Size box. The fonts look best at the cata­
loged sizes, but you can specify other sizes. The nearest matching 
fon t is scaled to the size you want. 
When all the sett ings are what you want. be sure the disk that you 
booted from is in the drive so the f ont Manager can load the font 
you have chosen from the ISYSTEMIFONTI folder, then click on [Ok] 
to install the new font and use any size or style changes that you have 
made. If the Fonl Manager cannot load the chosen font. it \1,1i11 default 
to the nearest matching font it can find. Click on (Cancel] to discard 
any changes and keep the original font, size, and style. 

Arrange 
This menu item works with selected text objects that have been typed 
using the Text tool. It's dimmed if no text objects are selected. 
If you need help selecting objects. work through the Trying Out 
Architectural Design section in chapter 1 and see Selecting Objects 
in chapter 2. See the Text Tool section of chapter 2 {or how to type 
and create text objects. 
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After selecting Arrange, the following dialog appears: 

Arrange Text 

Horzontal- Vertical-

DRs Is 181 As Is 
DLeft DTop 
181 Center o Center 
o Right o Bottom 

« Ok JI ( Cancel l 

Options on the dialog are selected when an [X] appears in th e box 
beside them. Click on the box to select an option. 

Horizontal Options. Use these options to arrange selected text 
horizontally (left - right) on your drawing page. not just within the 
drawi ng wi ndow. You can use View under the Options menu to 
examine the results. 
Use lAs Is] to keep your text where it is hori zontally or select lLeftl, 
[Center]. or [Right] to position text as the left edge, in the center, 
or at the right edge of your drawing, respectively. 
Vert ical Options. These arrange text vertically (top - bollom) on 
your drawing page. Here again, you can use [As Is) for no change. 
or select (Top], [Center]. and [Bottom] to position the selected text 
as desired. 

Objects Menu 
Just as the name implies, the items under this menu let you choose 
predrawn commonly-used, architectural objects (shapes and symbols). 
The items that let you see and choose predrawn objects include Bath. 
Doors. Windows, Stairs. Electrical, and Other. If you select any of 
these. a dialog appears so you can see and choose a specific object. 
A box encloses the object that will be chosen if you click the mouse 
button. Move the mouse so the box surrounds the object you want. 
then click. Objects are placed in the center of the drawing window 
and the Selector tool is activated so you can easily move them to the 
location you want. 
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Each letter on the keyboard corresponds to more commonl}' used 
objects. You can add them to rour drawing Quickly simply by press­
ing a letter for the object rou want. When possible. the first letter 
of an object's name is used. For example, [8] for [Bathtubl or [DJ 
fo r [DoorJ. Sometimes the previous or following letter in the alphabet 
gives another orienl.:1tion of the same object. such as [A] for a bathtub 
rotated 90 degrees (horizontal orientation). A Quick reference card 
is included with Architectural Design showing \\'hat objects correspond 
to what keys. 

When a letter is pressed. the corresponding object is placed in your 
drawing as described above, and the Selector tool is activated so you 
can posi tion it. 

You can also create and save your own custom objects for later use. 
The remai ning choices in the Objects menu let you choose custom 
objects. save new ones, clear (delete) them. or load and save them 
to disk. Each of these items are described below. 

Custom 
This menu selection lets you pick a custom object and add it to your 
drawing. Before you can pick a custom object, you must create some 
or load them from disk. 

Your program disk has a sample custom object file called 
CUSTOM.OBJS. You can use the Load From Disk menu item to 
load them (see below). 

You can also create you r own custom objects. See Save To below 
for how. 

Once you have created or loaded some custom objects. select Custom 
to use them in your drawing. The way you choose which custom ob­
ject you want to use is the same as the way you choose a ready-made 
object. When the custom dialog appears, use the mouse to move the 
selection box and enclose the object you want, then click. The chosen 
object appears in the center of the drawing window. It is automatically 
selected so you can easily move it where )'ou want it (see Moving 
Objects in chapter 2 for help moving). 

You can also select up to 26 custom objects from the keyboard. To 
do so, press the Icontrol] key and a letter. The letter IAJ selects the 
fi rst custom object, the letter IBJ the second, and so on. You can create 
your own command cards. or lists, of which keys correspond to what 
objects. You may select up to 26 custom objects in anyone custom 
object file and can have any number of fil es then load them from disk 
as needed, or you can select additional objects by choosing Custom 
under the Objects menu when there are more than 26 objects. 
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If more objects are available than will fit in the dialog wi ndow at one 
time, a More button is shown. Click on the More button until rou 
see all the objects or the one you want. 

Save To 
You can create your own custom objects and use Save To to save 
them. Once saved, select Custom (above) to use them in your draw­
ing as needed. If you lVant to keep your custom objects permanently, 
be sure to use Sal'c To Disk below before you quit Architectural 
Design. 
You can load custom objects saved to disk and use them again later 
or in other drawings with Load From Disk (also explained below). 

Save To lets rou save only grouped objects as custom objects. To 
create and save a custom object. you must first draw it. Use any of 
the drawing tools to draw a custom object. 
Once your custom object is drawn, click on the Selector tool. Now 
select all the individual objects that make up your custom object so 
you can group them into one object. Either press the Apple key and 
click on each object until they are all selected, or move the pointer 
outside the objects, press and hold the mouse button, drag the selec­
tion box around all of the objects, then release the button to select 
them all. Once selected, choose Group from the Edit menu to group 
them into a single object. Now you can choose Save To and save 
your grouped object as a custom object. 
You can select and group entire rooms if you want, then save them 
as custom objects too. Or use this feature to create your own libraries 
of custom objects that you can load and use in your drawings as 
needed. 

Clear Some 
You can delete one or more unwanted custom objects. To do so, select 
Clear Some. 
Choose objects you want to clear (delete) the same way you choose 
them to use in your drawing. Use the mouse to mo\'e the selection 
box and enclose the object you want to clear, then dick. Do the same 
to clear more objects or dick [CancelJ when done. 

Warning: Use care clearing custom objects. You cannot reco\'er 
an object once it has been cleared! 

Clear All. 
Choose Clear All to delete ALL custom object~ . You are given a 
chance to change your mind before the clear takes place. Be sure 
you no longer want any of the custom objects before you do the dear. 
You cannot recover the cleared custom objects! 
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Load From Disk 
Use Load From Disk to load custom objects from disk. You can load 
the sample cllstom objects called CUSTOM.OB1S or load objects you 
created and saved with Save To Disk below. 

Before the load occurs. you are given the option of clearing any existing 
custom objects or addi ng the objects you're going to load to them. 
This lets you merge custom object files together or load more than 
onc group of objects at a time. 

Once the objects are loaded, you can select Custom (sec above) to 
use them in your drawing. 

Save To Disk 
To permanently keep custom objects you've created. use this menu 
choice. The standard disk dialog will appear and let you name a fil e 
fo r your objects. 

You can create as many files of custom objects a~ you want and save 
them for later usc in your drawings. 

Before quitting Architectural Design, be sure to use Save To Disk 
and save custom objects you want to keep permanently. Any objects 
that are not sa\'ed to disk are lost when you select Quit or turn off 
)'our computer. 

Options Menu 
See Full View 
Select this to see your entire drawi ng at once, Click the mouse but· 
ton or press a key to return to the work screen. 

Show/Hide Rulers 
Choose Hide Rulers if you don't want visible rulers while drawing. 
If rulers are not used , this item changes to Show Rulers so you can 
use them later if you want. 
The ruler units change depending on the scale and grid spacing you 
set up. Where the rulers meet at the top left corner of the drawing 
window, )'ou'll see an abbreviation of what the working unit is as 
follows: 
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ft - feet 
in - inches 
cm ... centimeters (when Scale is set to metric) 
mm - millimeters (when Scale is set to metric) 

Numbers on the rulers represent real-world distances in the scale you 
afC using. Before beginning a serious drawing that uses rulers and 
precise measurements, be SUf e to read the Scale and Grid sections. 
You'll want to begin with the correct scale so your drawing page width 
and height are large enough to accommodate what you are drawing. 

Show/Hide Measurements 
After }'Ou select Show l\l easurements, an object"s size appears above 
the drawing window as you are drawing it. r or rectangular objects, 
width and height measurements appear. Length and angle 
me,lSurements are shown (or line objects. 
Performing calculations and updating the measurements does slow 
down drawing so you'lI want to use measurements only when they 
are needed. You can fi nd an existing object's size by selecting it and 
choosing Info under the Edit menu. or by mO\'ing onto its lower right 
handle, then pressing and holding the mouse button (when Show 
l\Jeasurcmcnts is activated) . 
After you choose Show Measurements, it changes to Hide 
l\leasuremcnts so you can remove the measurement display if it is 
no longer needed. 

Measure In ft . dec 
The default measurements are shown in feet· inches. r or example, 
3'3/1 . You can also show the measurements in feet· decimal. The 
example just given would then become 3.25. Choose this menu item 
to change between the two options. 

Snap To Grid 
A check mark beside this menu item indicates grid snap is enabled. 
When enabled (turned on), the start location for the object you are 
drawing is automatically adjusted to coincide with the nearest 
horizontal and vertical grid intersection. Then as drawing continues 
(via dragging), all points or line ends arc adjusted to the nearest grid 
intersection, (i.e. snapped to the grid). 
You can turn on and use grid snap e\'en if the grid lines are hidden. 
This feature is especially usefu l for drawing objects which must be 
exactly the same size or horizontally and vertically aligned. Don't 
forget, you can also press [Apple-Y] to Quickly toggle the grid snap 
on and off. See Grid for more related information. 
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Auto Scroll 
The Auto Scroll feature is enabled at start-up as indicated by the 
check mark beside it. While enabled, if you draw beyond the bottom 
or right side of the window, your drawing is automatically scrolled. 
This lets you morc ea~ ily draw objects that are larger than the window 
viewing area. 

If you don", want to use Auto Scroll, sclect this item to disable it. 
When disabled, you can use the scroll bars to scroll your drawing 
if you need to. Click on the scroll bar arro\\'s for small moves. in the 
page area (beside the box) for larger moves, or drag the scroll bar 
box to position your drawing as desired. 

Scale 
When you choose Scale . the following dialog appears: 

runi ts 
_ [2} Feet-Inches o Hetl"ic I 
-Sca le 

01/32" = l' @ 1/8 " = l' 0 1/2 " = l' 
0 1/16" = l' 0 1 / 4" = l' 0 1"=1' 

Or-m'ling \'Iid th: I 64.00 1ft 
Height: 44 ft 

o Rescal e Objects 

I( Ok 1I ( Cancel ) 

You can select Scale to change your drawing scale. or to see what 
the current scale is. The round button beside the current scale is 
automatically selected (darkened) when the dialog appears. 

Units. Click on the box next to the type of units you want to use. 
either feet-inches or metric_ A chosen box has an IXI inside il. If you 
select metric. the standard scale choices (see below) change to metric 
scales. 

Scale. Choose one of the six most commonly used scales or type the 
width you want (or your drawing. Click on the bulton beside a stan­
dard scale to select it. or simply begin typing to specify your own width 
(scale) . The maximum width you can use is 10.000 feet per page 
(80.000 feet for the largest possible drawing size that is 8 pages wide). 
or 10.000 centimeters per page if you are usi ng metric units. Use 
the Idelete] key to edit your typing. 
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Rescale Objects. Click on the box beside this option if you I\tant 
the size of objects changed (rescaled) when you change scales. When 
the box is empty. object sizes are not changed . Following is more 
related information (see the Scale changing problems section also). 

Choosing a scale. Do some planning before choosing a scale. When 
Architectural Design begins. the scale is 114" - 1 '. This means when 
you print a hard cop}'. I inch on paper is equal to 4 feet in the real 
world. Since a one-page, printed drawing is 8 inches wide, the real­
world width of a page is 32 fee t using the start-up scale. 
If the project you arc beginning wil! be larger than 32 feet wide. then 
you'll need to set a drawing size larger than one page (a drawing that 
prints on 2 or more pages of paper - see Drawing Size later in this 
chapter) or choose a different scale if you want to keep your drawing 
size 10 one printed page. Each step in the standard scale choices 
doubles the drawing width. or cuts it in half. So if ~'ou choose 1/8" 
- I ' . your drawing's page width increases to 64 fee t. The maximum 
width for the standard scale choices is 256 feet with the 1/32" - I' 
scale. If you want a drawing page width that's wider than 256 feet. 
you'll need to type the width you need. 
You should consider the height of your drawing too. The height is 
shown in the scale dialog below the Page Width . It automatically 
changes as you select different scales or type a width. You cannot 
change a page's height independently so that the width to height ratio 
of a printed page-is maintained. You can independently control the 
number of pages high your drawing is (see Drawing Size). 
When the scale is what you \\1ant. click on [Ok) to change to the new 
scale. or click on ICancel] to discard any changes and stay with the 
origi nal scale. 
Note for LaserWriter users: Horizontal scale adjustments must be 
made when printi ng to a LaserWriter. The adjustments are needed 
to make drawings print to scale correctly. For this reason. approx­
im ately one half inch is lost on the right side of the drawing page. 
If you plan to do a LaserWriter printout. lake this into consideration 
and don't draw right up to the right edge of the drawing page. Leave 
an inch or so to allow for the horizontal scale adjustment. This is 
needed only for the LaserWriter. 

Scale changing problems. Although Architectural Design can rescale 
ally existi ng objects when you change scales. it's much better to 
choose the correct sc.1/e before you begin dr.1wing and stay with 
that scale. Due to rounding. differences in line widths, screen resolu­
tion, and for other reasons. objects rna}' become misaligned to some 
degree during the rescaling process. In general. the more drastic the 
change in the scale, the greater the chance of halting problems when 
your objects are rescaled. Another side effect is that the scale change 
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could cause objects to go beyond the bounds of the drawing arca in 
the new scale. creating additional problems. 

f or the reasons listed abo\'c. if you try to resc"/c ,1n existing draw­
ing, )'ou should "/I...,Ys sal'c a copy to disk .1S ,1 safeguard first! 
Once objects ha\'e rescaled duri ng a scale change. you may not be 
able to simply go back to the original scale and ha\'e them be as they 
were! The next scale change rescales objects based on their new size 
and new coordinates. 

The same alignment problems can occur with the predrawn objects. 
They were designed (or the start-up scale. 114" - I'. When you change 
scales. a predrawn object is automatically resized to the new scale 
when you choose it under the Objects menu. or when you display 
it by pressing a keyboard letter. The greater the change from the start. 
up scale. the morc likely it is that an object will not scale perfectly 
(the end of one line may not meet perfectly with another line. etc.). 
If you need to. you can ungroup a predrawn object (see Ungroup 
and Resizi ng Objects) and correct small problems that may occu r 
with rescaling. 

Grid 
Choose this menu item to set the spacing of the grid or show and 
hide the grid lines. After choosing this item. you'll see this dialog: 

u 

Gdd 5 00cing 

06" 
@1 ' 
0 1' 6" 

8" 2 ' 6 " 
OJ' 

o ShOI'/ Grid 

o 5noo To Grid 

Ok JJ ( Co ne"t 

Grid Spacing. For any gh'en scale, you' lI have six choices for the 
grid spacing; choose the you want b}' dickingon the bulton next to it. 

Show Grid. An IXI in the box beside this option causes grid lines 
to show. Click on the box to select or empty it. 

Snap To Grid. This is the same as the Snap To Grid menu choice. 
You can cl ick on the box beside it here to turn the grid snap on and 
off. or use the menu item. The menu choice was included for faster 
access to this often-used (eature. 

Click on (Ok l to keep the new grid settings. or d ick 011 (Cancel] to 
discard thcm and use the origi nal settings. 
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Drawing Size 
This item lets you change the page size of )'our drawing, which in­
creases or decreases the amount of space inside the drawing window. 
Each page in size corresponds to a printed page on paper. so if you 
create drawings that are larger than one page, they print to more 
than one page on paper. You can trim the edges off the paper and 
attach the pages together to make a large-drawing printout. YOll may 
prefer to use the No Gaps Between Pages option under Page Setup 
when printing multiple-page drawings (this option is turned on when 
the program starts). This causes the drawing to print continuously 
down the paper \'ertically (right through the perforations). You will 
need only to attach each vertical column side by side to complete 
the entire printed drawing. 
When Arcllitectur;il Design begins, the drawing size is set to 1 page 
wide by 1 page high . You can create drawings that arc up to 8x8 
pages in size, however. you should li mit the size to what you really 
need (or a given project. Remember th at an 8x 8 page drawing con­
lains a total o( 64 pages which could take a considerable amount of 
time to print. It's unlikely that you would ever need a drawing that 
large but the oplion is availablc. The width and height do not ha\'e 
to be the same. The following drawi ng size examples are all okay: 
1 x2: 2x I: 2x2: 2x4: 4x4: and so on. 
To change the siz~. select Drawing Size from the Options menu 
then type the desired width and height. Use the tab key to mo\'e be­
tween size boxes. or click on the box that you want to change. Use 
Ideletel to edit your typing. Click (Okl to use the new size or (Cancel] 
to keep your original size. 
If you arc changing the size of an existing dri.lwing. you cannot reduce 
its size smaller than the number of pages currently used by the draw· 
ing. The number of pages used are shown. and the range limi ts (or 
the width and height are shown in parenthesis, (). It's okay to increase 
a drawing's size up to the maximum size li mits, and if necessary, you 
might delete part of a drawing or change the scale using the re-scale 
objects option to reduce its size so }'OU can decrease the number of 
pages it uses (see Scale) . You can also print using 50% reduction 
to print a drawing using half the number of pages it ..... ould normally 
require (see Page Setup), 
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Stud Tool 
Select the Stud Tool menu item to change the parameters for the 
Stud dra\\'ing tool. The changes you make to the parameters Me 
remembered and used when you drilll' studs by clicking on the Stud 
tool icon. See Stud Tool in chapter 2 for inform'ltion on how to draw 
studs. 
After selecting Stud Tool, you'll sec this dialog: 

S tud Tool Por om et. .. r } 

Sp a c ing . O.C- ~ Ilon " d Si~e 

~ "" 0 24"' [![] i nch !o i de 
16" O '-l 8" , 

Other: WJ E) . nch tOil , 
~ft I t' nsth 

[0~ii~ [[]] ~Elrn8 I 
II Ok JI I Cone,, 1 I 

Spacing, D.C. O.C. stands for a conl rilCtor's term. all Center. It's 
the spacing between studs measured from thc center of the bOilfds. 
You can sci the spacingyoll want for your studs or boards. Four com­
mont)' use<.l spacings arc provided. Click on a button beside one 10 
choose il. To specify a spacing other than those provided. use the 
tab key to move to the Other box. or click on the box to move In 
it. then type the spacing you want. 

Board Size. If you want to change the board size. use the t(lb key 
to move to the desired box and type the size you want. or click on 
(l box to movc to it for Iyping. There's more related informiltion on 
bOilrd size belol\'. 
Orientation. You can change how you want to vicw boards byclick­
ing on the desired orientation icon. The currently selected orienta­
tion is high lighted. 

Begi nni ng from the left , the first two icons ilre top l,jeWS. The next 
pai r of icons represent side views. The last four icons are various 
orientations of end views. If you want to view from the top with a 
hori zont<ll urient<ltion. click the first icon on the left . 

The size of the orientation icons will not change as you specify the 
hO(If(.lsize: only the size of the studs in your drawing will ch<lnge. 

When using the Stud 1001 to draw. you hal'c di rec t control ol'er the 
length of studs I'iewed from the top or side by draggi ng a sizing rec­
timgle to thc size you want. The arca the rectangle encloses 1\'ilI be 

.i:! 

fi lled with sluds. See Stud Tool in chapter 2 for help drawi ng studs. 
The rectangle defi nes the length of the studs and the width of the 
area you want fi lled with studs. as shown here using the default start­
up orientation: 

This becomes thIS. 

The length of studs drawn from an end view is unknown unless you 
specify it in the Stud Tool dialog box. When you selecl Info for a 
stud object viewed from the end, the length that you spedfy in the 
di<llog box is used (or all the information calculations. Be sure to pro­
vide the correct length parameter in the dialog box for end views. 
or information shown with Info will not be correct. 
When you have all the stud parameters set the way you want, cl ick 
on (Okl to keep them, or click on rCancel) to discard any changes 
and use the original parameters. 

Patterns 
Choose Patterns to change existing patterns or to load patterns from 
disk. After selecting this item, this dialog appears. 

Click on to Edit 

Working POl '"'' .j.1-.J<; 
(Click for next 
page of pa1terns) 

Save Pattern to Disk 

,,, 
Act ive Color 

Click to Discard 
Changes & 
Quit Edit ing 

Load Pattern from Disk 

53 



To edit a pattern, click on the pattern you want to change to make 
it the working pattern. then click on the color you want to use. f.-10re 
the pointer onto the pattern square that you want to change and click 
(in the large box on the left). You can hold the button down and move 
the mouse for continuous drawing. Squares under the pointer change 
to the working color. The reference area in the large box on the right 
is updated for a true size perspective of your changes. 
You can get the next page of patterns by clicking on the working 
pattern square that's next to the line of patterns in the palette. 

To copy patterns, move onto the pattern you want to copy. then press 
and hold down the mouse button. Move the pattern 's outline to the 
new location and release the button. You can drag the outline off 
the left or right end to copy to Ihe next page of patterns. 

Click on [Save] to save a permanent copy of your patterns to disk, 
or click on ]Load] to load patterns that you have previously saved. 
If you click on ]Cancel], all changes made to the patterns are discarded. 
the pattem dialog disappears, and your original patlems are restored. 
If you click on ]Ok], all changes to the patterns arc kept. the pattern 
dialog disappears, and your working patterns on the palette are 
redrawn using the newly changed patterns. Until you make other 
changes to your drawing or colors, you can sti1] click on [Undo] to 
restore your original patterns. 

Default Patterns 
This menu item initializes the palette patlems to the default patterns, 
the same as when Arcl!itectural Design first begins. Select [Undo] 
to reverse this selection, 

Default Colors 
Default Colors initializes the palette colors to the standard default 
colors, the same as when Architectural Design first begins. Click 
[Undo] to reverse this selection. 

5-Using Paint Your Own 
Home 

While an object oriented program like Architectur<'li Design is an ideal 
tool for drawing floorplans and arranging architectural symbols, there 
may be times when you'll want to work with a drawing in ways that 
only a paint program can. You can do things with paint layer draw· 
ings that you cannot do with an object oriented program like Architec­
tural Design. For example, you may want to zoom in and edit your 
drawing at a single dot (pixel) level, fill irregular areas with colors 
and patterns, or use various types of paint brushes. For your cotl\'e­
nience, we've included a program called Paint Your Ol\,!l Home 
(PYO H) with Architectural Design so you can save drawings as paint 
files and use paint-type features when you prefer. In additlon. Paint 
rour Own Home lets you load clip art screens. You can create your 
own clip art or experiment with the sample clip art that's provided. 
j\lany of the Paint Your Own Home features, such as lines, rectangles, 
and ovals work like they do in Architectur<'li Design, except they draw 
paint layer images rather than create objects. Features that are dif­
ferent or apply only to Paint Your aII'll Home are explained here. 
When features work the same, you are referred to other sections of 
this manual. 

Starting Paint Your Own Home 
Before starting Paint YOU/'Oll'n Home, if you have not already done 
so, refer to the "Making A Backup" section and make backup copies 
of the Architectural Design disks that you received. 
Note: If you are already using Architectural Design, you can select 
Quit under the File menu to return to the Finder. In this case, you 
do not have to turn off your computer and start the Finder from 
scratch, so you can skip the steps described in the following paragraph. 
The first step to starting Paint YO!JrOll'n Home is to start the Finder. 
To do so, insert the Design Your Own Home (DYO H) system disk 
into your drive, turn off your computer (if it is on), wait for about 
30 seconds, and turn it back on again. 
Once the Finder screen appears, if you have one drive, remove the 
DYOH system disk from your drive and insert the Architectural Desigll 
program disk. If you have two drives, insert the program disk into 
your second drive. A window with the name DYOH.Architect at the 
top of it opens automatically, 
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If for some reason the \\'indow does not appear, you can open it 
yourself. To do so. use the mouse to move the arrow pointer onto 
the disk (or volume) icon that has the name DYOH.Architect beneath 
it. then double-click the mouse button. 

The Paint Your Own Home application !con is inside the DYOH.Ar­
chitect window (if you had to open the window yourself. you may 
need to use the window's scroll bars to find the icon). It has the name 
Paint.Home beneath it and looks like this: 

Paint Your Own Home drawings that you create and save to disk. 
as well as clip art or any picture file that you can load appear with 
a document icon when viewed from the Finder screen. The docu­
ment icon looks like this: 

Ib 
nV.HOnE 

To start Paint Your Own Home from the Finder screen. insert your 
backup copy of the program disk into your drive. Then move the 
pointer onto the Paint_Home application icon (not the name) and 
double·click. 

Drawing And Color Tools 
f.'!any of the drawing tools and all of the color tools are the same as 
those provided in Architectural Design. See chapter 2, ·'Drawing 
Tools". for a complete description of the drawing tools that are not 
described here and refer to chapter 3. "Color Tools·', for a descrip­
tion of all the color tools. When Paint Your Own Home starts. you'll 
see these drawing tools: 

Selector 

Rounded Rectangle 

Oval 
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Though th e hollow line tool isn't visible in the tools window, it's still 
available. To use it. select the line tool. click the line width you want. 
then hold down the option key while you draw, 

Selector Tool 
To use the selector tool. click the dotted box icon (the top tool), Now 
move into the drawing window. press and hold down the mouse but­
ton, and drag the resulting dotted box to the desired size. Then release 
the button, 

The area enclosed by the selector box remains selected as indicated 
by the animated box (it appears to flash or rotate) . You can manipulate 
the selected area with items under the Edit menu (see ";"!enus" in 
this chapter), or you can use the mouse to move or copy the selected 
area, You can press delete to quickly erase the selected Mea. 

To move the selected area (or image), position the pointer anywhere 
within the animated selection box. The pointer changes to an arrow 
\\1hen it is within the selection box. Press and hold down the mouse 
button and move the dotted outline to the desired location , then 
release the button. The image is era<;ed and moved to the new loca­
tion. To make a copy of a selected image. hold down the apple key 
before you press the mouse button. The original image is left as it 
is and a duplicate is copied to the new location when the apple key 
is pressed . Select Undo to reverse the most recent change. 

You have the option of having images drawn to the screen in either 
of tll'O drawing modes. replace or Ol'Cr/.1Y. This applies to images 
that are moved and copied. dip art images. and those that are pasted 
into your drawing using Paste. The replace mode draws an exact copy 
of the area that's within the selection box, induding any white 
background area. The overlay mode causes white. the background 
color, to be treated as a transparent color. So only colors other than 
white, the foreground colors, that are within the selected area are 
drawn (overlaid) to the screen. If you want \\'hite to be treated a<; a 
foreground color and not be transparent. you can set a another palette 
color to white with the Mix button and use it as a foreground color. 
The only white that becomes transparent is the one at the rlght end 
of the color palette (this applies to patterns as well). 

When the program starts, overlay mode is used. You can temporarily 
ol'erride whichever mode is active by holding down the option key 
before you move, copy. or do any operation that draws a selected 
image to the screen. You can also select Use REPLACEIOVERLAY 
1\10de under Edit to change the active mode. The new mode is used 
until you change it again with the same menu item. or override it with 
the option key. 
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Paint Brush Tool 
To use this 1001, click the paint brush icon in the tool window. ]\10\'c 
into the drawing \\'indow. press and hold down the mouse button, 
then move the mouse. 

Additional paint brushes are iI\'ailablc. To choose a brush, you can 
hold the apple key down and press B. or seiect the Paint Brushes 
item (rom the Options menu . Then move the selection box left or 
right with the mouse and click the button to select the desired brush. 

Fill Tool 
Thi~ tool lets you fi,lI an area with a color or pattern. To begin. click 
the Icon that looks hke a paint can tipped to the left (\\'ilh paint pouring 
out). then d ick the color or pattern rou want to usc. Position the 
center of the pointer exactly where you want the fill to begin and click. 
If you fill a large area, it may take a few seconds to complete the fill. 
You'll see a watch cursor indicating the program is working. If needed. 
select Undo to reverse the fill. 

NO.te: This is a vert.ically limited fill. This means the fill begins at the 
pomt where you chck and fills upward and downward until a color 
different from the color you were on top of when you clicked is en­
countered, Though you may need to click at more than one location 
to fi ll complex areas with this type of fill , you can use this feature 
to your advantage because rou have a greater degree of control. 

Zoom Tool 
This tool lets you zoom in on (or magnify) your drawing. Each pixel. 
or screen dot, is enlarged so you can easily see and change an in­
di~idual pixel. To begin, cli~k on the icon that resembles a tilted magni­
fymg glass. Now you can lIlcrease or decrease the magnification by 
selecting a size in the line width window, You'll probably need to use 
the scroll bars afterward to mo\'c to the area of your dra\\' ing that 
you want to edit. 

To draw. click on the color or pattem you want to usc. move the 
pointer onto the pixel that you want to change, then click. You can 
also hold down the mouse button and move the mouse for continuous 
drawing. Hold down the apple key and press W or select See Full 
View under the Options menu to see your changes at their normal 
size. Use Undo to reverse the most recent change. 
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Menus 
All the P<lint )'0111' OIl'Il Home menu items under the Fil e and Text 
menus work as described for Architectural Desigll. f- Iany of the items 
under Edit and Options do also, Please refer to chapter 4 (or a 
description o(those. f-Ienu items that apply to Paint rour OIl'Il Home 
only. or those that arc implemented dif(erently, are described here . 

Note: The Cut. Copy, Paste. and Clear items work as in Architec­
tural Design except the clipboard is maintained in memOl)' rather 
than on disk. 

Load/Get Clip Art 
Usc this item to load clip art screens. Clip art screens are standard. 
unpacked. lies picture screens. You can draw your own clip art using 
Paint )'ollr Oil'/) Home (or any other paint program that leis you s,,\\'c 
standard unpacked pictures), then use this item to load the images 
for usc in your drawing, If you need help using the load file dialog, 
sec "Open" in chapter 4, 
After the clip art sc reen loads, it 's sl1o\\'n on the screen so you C;II) 

select an image (or area) to add to your drawing, For future selec­
tions, you'll need to choose Get Cli p Art. 
To select an image. hold down the mouse button and drag the resulting 
selection box around it just like you do whcn using the selector tool. 
When you release the button. the image is placed in your drawing 
and automatically selected so you can position it as desired. The selec­
tor tool is automatically activated also. If you don't want to place any 
clip art into your drawing. simply click \\'it hout dragging the selec­
tion box around anything. Th is lets you use Load Clip Art without 
immediately having to add something in to your dril\ving, or leis vou 
select Get Clip Art for viewing only. Remember, you can select i ~'ely 
use overlay or replace drawing modes to control how images are drawn 
(see the "Selector Tool" section in this chapter). Undo removes an 
image should you change your mind after sclecting it. 

Copy Drawing > Clip Art 
This item copies your entire drawing page to Ihc clip art page replacing 
any clip iu11hat is presently there. Select Undo to restore your OIiginal 
clip art (before doing anything else). 
If you arc not using clip art, this is a handy feature for keeping a tem, 
porary backup copy of your current drawing. It leis you experiment 
by making multiple changes to your current drawing and use Copy 
Cli p Art > Drawing to restore your original if you don't like the 
changes, 
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Copy Clip Art > Drawing 
You can use this to copy the clip art page to the drawing page. The 
clip art replaces any current drawing. You can select Undo (before 
doing anything else) to restore your original drawing. 

YOll might want to use Copy Drawing > Clip Art and this item to 
save a backup copy of your drawing and later revert back to the backup 
cop}" or to transfer cl ip art to the drawing window so you can edit 
it . Afterward, you could save the edited clip art with Save As and 
use it at a later time. 

Swap Drawing < > Clip Art 
This menu item exchanges your drawing with the clip art page. Vou 
can select Undo or this item a second time to restore both your drawing 
and the clip art. 

You can use this when you need to make minor changes to clip art 
before using it with your current drawing. 

Use REPLACE/OVERLAY Mode 
Choose this to change the drawing mode that's used to draw images 
that are moved. copied, and pasted into your drawing (including clip 
art images). The Use REPLACE Mode item changes to Use 
OVERLAY Mode after it is selected (and visa \,ersa) so you can change 
to whichever mode is not currently active. 

Please refer to the "Selector Tool" section ncar the beginning of this 
chapter for a complete description of how these modes work 

Paint Brushes 
This menu choice lets you change the paint brush that's used for paint­
ing with the paint brush tool (the icon too1). To choose a brush after 
selecting this item, usc the mouse to move the selection box left or 
right to enclose the desired brush, then click. The selected brush 
is used the next time you use the paint brush tool. See the "Paint 
Brush Tool" section of this chapter for more. 
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Appendix A 
Error Messages 
No clipboard file 
This error message indicates there isn't an Architectural Design clip­
board file on the last disk that you used. This occurs if you tt)t to 
Paste before using Cut or Copy. Use Cut or Copy to create a clip­
board file and place (cut or copy) objects into it, then don 't change 
disks before you use Paste. If you need to switch disks, do it before 
you periorm the in itial Cut or Copy since the working disk is used 
for the clipboard file. You can make another disk the working disk 
by cataloging it (with Open for example), then cli cking Cancel. 

Object file I/O 
You'll see this only when Architectural Design first starts if no pre­
drawn objects can be loaded. You can click Ok and still have limited 
use of Architectural Design (you can't usc pre-drawn objects), To avoid 
this error, if you've copied Architectural Design to a different volume 
or Hard Disk. be sure the Arch.Data folder resides in the same folder 
as the Architectural Design appl ication and that it contains a good 
copy of the Arch.Objs file. 

Pattern file I/O 
You'll see this only when Architectural Design first starts if no pat· 
terns can be loaded. You can click Ok and still have limited use of 
Architectural Design (the default patterns for the pre·drawn objects 
will not be available). To avoid this error, if you've copied Architec­
tural Design to a different volume or Hard Disk, be sure the Arch.Data 
folder resides in the same folder as the Architectural Design applica­
tion and that it contains a good copy of the Arch.Pats file. 

A 1MB + system is needed 
This is shown at start-up if your computer doesn't have enough free 
memo!)' for Architectural Design to start. 

ProDOS (GSOS) I/O 
The operating system was unable to read or write data to disk. The 
reason may vary. The disk may be physically damaged or have had 
data on it compromised in some way. 
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Write· protect 
A disk is write-protected and cannot be written to. Remo\'e it from 
the drive and disable the write-protect tab. Sec chapter I for how. 

Volume or Path not found 
This might occur if you s\\:itch disks or remOl'c a disk from the drh'c 
and try to do a Save. Cut, or Copy. Sec the "No clipboard rile" sec­
tion above and "Si\VC" in the "Menus" chapter for related informa­
tion. You can use Save As to save to a different disk 

Volume full 
There isn't any morc room on the disk. YOlI"U need to save 10 a dif· 
ferent disk or initialize (with the Finder) another data disk to usc. 
See the "Cetting Started" section in chapter 1 fo r help making data 
disks. 

Invalid directory 
The directory or subdirectory on the disk has probably been com­
promised. You'Ulikcly need to use the Fi nder and copy all the files 
you can to another disk. then initialize and verify the bad disk. Discard 
the bad disk ifit does not verify i.l~ being error-free after it is initialized 
again. 

Out of memory 
You don't have enough free memory to do whatever it is you arc 11)" 

ing to do. If you arc using a RAt-l disk. you may be able to set it to 
zero or reduce its size to free more memory. Be sure to turn your 
computer off and restart after doing this. 

, .. , '. 

Appendix B 
Setting The Control Panel 
For Printing 
Using The Control Panel NDA 
The latest version of Apple's system disk lets you change Control Panel 
settings using a New Desk Accessory (NDA) called Control Panel. 
This section describes how to use it to set your Control Panel for 
printing. For complete information about this desk acceSSOI)' and 
the latest system disk. contact your local Apple dealer. 
If the Control Panel item is available under the Apple menu, select 
it to set your Control Panel for printing. otherwise, see the "Using 
The Control Panel CDA" section (below) for selting ~'our Control 
Panel. 
When the Control Panel window appears on the screen. Click on the 
icon for the type of printer setup that you have. DC Printer (Direct 
Connect Printer) for an ImageWriter printer (or other printer that 
isn't on an AppleTalk network). You may need to use the scroll bar 
to find the icon. Click on the name of the printer you have. and on 
the port irs connected to at the back of your computer. Don't write· 
protect the DYOH system disk so the settings you choose can be 5<1\'ed 
to disk, then ~'ou won't ha\'e to do this the next lime you start 
Architectural Design. 
Now find the Slots icon and dick on it (use the scroll bar if needed 
to fi nd the icon). To change a slot. move the pointer onto the box 
beside its number. hold down the mouse button and move the mouse 
to select the desired option then release the button. Use this pro­
cedure to set slOl~ 1, 2. and 7 as appropriale for your hardware selup 
(see 114 in the "Using The Control Panel CDA" for more help with 
slol settings if needed). Click the close box at the top left corner of 
the Control Panel window when finished. 
Note: When using the <:;ontrol Panel desk accessory. the options 
shown in italics arc the default settings. The Alphabet keyboard 
translation must be set to None (if not al ready). This is how the CS 
translates characters and it's required for the option key to work cor· 
rectly with Architectural Design. The Standard setting is how the 
Macintosh translates characters. 
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Using The Control Panel CDA 
This sect ion helps you set the Control Panel for printing. If you have 
already started Arc/Jitectural f)esign. you'll need to S;;!\'C any existi ng 
design since you'll have to resL:i1t your computer after working through 
this section. Please consult your Apple JIGS Owner's Cujelc for more 
information about the Control Panel. 

1. If your computer is on. press the .1ppJe, control . and esc keys 
simultaneously to access the desk accessories menu. If your compuler 
isn't on, hold down the option key and turn it on. then at the resulting 
menu, press I and go to step :l. 

2. Usc the up or down arrow key to highl ight the Control Panel item 
and press return . 
3. Usc the up or down il ITO\\" key to highlight the Slots item and press 
return . 

4. Now. use th e ,lrroll'S to highligh t Slot I if your printer cable is 
plugged into the printer port at the back of your computer. or Slot 
2 if it is plugged into the modem port. Usc the right arrow key to 
change the highlighted slot a'i follows. 

a. If your printer is connected to the printer port . sct the highlighted 
slot (should be 1) to Printer Port. 

or 

b. If your printer is connected to Ihe modem port, sci the hip:hlighted 
:-;Iot (should be 2) to Modem Port. 

'" 
c. If you are using a LaserWriter or an AppleTalk network (a Laser­
Writer uses an i\ppleTalk network setup), set Ihe highlighted slol 
(\ or 2) 10 Your card and set Slot 7 10 Built-In-ApplcTalk. 

5. Press return to keep the new settings. highl ight Quit ,Ind press 
return again to ex it. 

6. Turn your compoter off and wait about 30 :-;econds before turning 
it back on. You need to turn your computer off to initialize the system 
wi th the new Control Panel sett ing. ... n efcr to the "Getting Started" 
section for help in restarting. 

Appendix C 
Setting Your RAM Disk To Zero 
Architectural Design requi res a minimum of I024 K (1MB) of free 
memo!)' to operate. so to ensure enough memo!)' is free. set your 
RAl'1 disk size to zero. The followi ng steps show rou how. 

1. If your computer is on. press the apple. control. and esc keys 
al the same time to access the Desk Accessories menu . If your com· 
puter is off. hold down the option key and turn it on. 

2. If you began with your computer off. press J to select Control 
Panel. If your computer was on. then al the Desk Accessories menu, 
usc the .1rrQW keys to highlight Control Panel and press i"f.~ turn . 

3. Use the up and down .1rrQII' keys 10 highlight RAM Disk and press 
return . 

4. Use the righ t and left .urolf' keys to set both the minimum ilnd 
maximum RAJI.\ disk sizes to zero and press return. 

5. Turn off your computer so the new setting.'i will take effect. Wail 
about 30 seconds. then you can St.lrt Architectural Design as described 
at the beginning of this user's guide. 

Appendix D 
Installing Architecture 
On A Hard Disk 
1. Usc the Fi nder to copy the Architect ure application file to the 
desired Hard Disk folder. You can use an existing folder or create 
a new folder. 

2. Copy the enti re Arch.Data folder that resides on the program disk 
(not the data disk) to the same folder that contains the Ar chitec· 
ture application file on the hard disk. 

:J . Cop}, the Arch.lcons tile inside the Icons folder of the original 
Architectural Design program disk to the Icons folder of the boot 
mlume on the Hard Disk so the Finder will use the Architec/ur,11 
Design program and document icons if you boot from the Hard Disk. 
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Front Views of Sample Plans 
These illustrations correspond to the plans on youI' data disk. 
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Extra Copies of Command Cards 

IIGS ARCHITECTURE COMMAND CARD 

SHAPES 
N '" Elevation Heights .... 4-
o '" OuUeI(110V) . . .... . .. . 4t> A '" Bathtub (Hafiz.) ... c:J 

B = Bathtub (Vert.) . . ..... D P '" Outlet (220V) . .. ~ 

C = Bathtub (Square) ... D 
o = Door (Top) . . . . .. . .. . (1 

E = Door (Side) . .... ~ 
F = light Fixture .......... Q) 

G = Chimney (Top) 

a ;0 Break Line .. 

A '" Shower (Oia9 .) .. .... $ 
S = Shower .. . ...... . . . . C8J 
T • Toilet .. . .. . .... . Ii' 

. .... S> U '" Toilet (Oia9 .) . 

v = Wire Jump . . . . . . . . . --"'-

H = Chimney (Side). . .. 0 W", Washbowl (Hariz .) . . . . ~ 

I = Steps /Slairs X '" Washbowl (Oia9.) . . . <0 
(Top Spiral) ..... . _ ... &J 

Y = Window (Top) .... 

J = Steps /Stai rs EEl 
(Top Diag, Spiral) ..... <J;p Z . Window (Side) .. .. . . 

K '" Steps/Slairs E3 
(Top Straight I) ... . .. E3 

L '" Steps/Stairs 
(Top Straight 2) .. .. . . §J 

M '" Scale Marker . . ..... . .......... 

MENU COMMAND KEYS 

a A ;; Select All au :IE Unlock 

cl B = Move to Bottom clV ;; Paste 

clC = Copy cl W .. View 

cl F .: Choose Font cIX = Cut 

clG = Group a Y .. Snap 10 Grid 

o H = Ungroup cj Z ;; Undo 

01 z:: Info a - .. Align with Grid 

OK = Close 0- ;; Rotate Left 

OL ;; Lock 0 1 '" Rotate Right 

OM = Show 0 " '" Flip Horizontal 
Measurements a : ;; Flip Vertical 

ON=New ' 

cJO = Open 
OBJECT GROUPS 

a P = Print 
0' '" Bath 

00= Quit 
02 '" Doors 

a R = Hide Rulers 03 '" Windows 
cJ S = Save O • .. Stairs 
aT = Move to Top 

05 '" Electrical 

06 '" Other 

00 '" Custom 

a +;: Save to 
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Other Abracadata Products 
Ad"'cnturc of Le.l rning: The rc\'olutionary (.>ducalional program fo r 
home and school. Runs or creates Learning f.1odulcs. Leaming Adven­
tures, and Entertainment Ad\'cntures. 

Design Your Own Train, the first transit system co nstruction set 
that puts a model railroad inside your computer. For all Apple II's 
(GS too). IBMlcompatiblcs: and for the Macintosh. /'tIacInoog.l 
Choo·Choo. 

Train Libr.,,)', Includes a dozen complete ready-to-go layouts will 
work with Design }'our Own Train or Run Your OWIl Train For Ap­
ple II , 1B~1, Macintosh. 

Run Your Own Train, the "flight simulator" (or down-ta-earth 
people. puts you in the engineer's seat as you run trains over layouts 
that you design yourself. Por all Apple II 's (CS too). IBM version 
coming. 

Everybody's PI.1nner, project management and nowcharting for all 
Apple II 's (eS too) and IBM/compatibles. 

Everybody's PI.1nner Reports, provides 13 extra reports fo r above. 
all Apple II 's (eS too) and IBMlcompatibles. 

Design Your Own Home, Architecture. Interiors. Landscape design. 
all Apple II's (eS too). ~lacintosh. IBI'ollcompatibles, special lies \·er­
sions available. 
Design Your Own Home Libraries, 4 Architecture, 2 Interiors. I 
Landscape libra!)', each with 48 complete plans. 7 libraries for each 
computer: Apple II , lies. Macintosh, IBM/compatibles. 
Landscape Regional Image Libraries, enable you to insert regional­
specific trees and other landscape items into your landscape plan. 
Five libraries (or Apple II. IIGS, IBM. 

lVelcome!, organizational handbook for any type of organization. 
for all Apple Irs (CS too). 

Electronic Drawing, 98 pre-drawn shapes make electronic 
schematics a breeze, all Apple Irs (GS too) and mr-.1Icompatibles. 

Graphics Superm.1rket, IIGS shape utility, creates and S.:"l\'es shapes. 
animates and (programmers!) provides source codes for the shapes: 
prinlo;: spec ial developer's version avai lable with complete program 
source codes (C and assembler): IICS. 
Write or call (I~ for morc information. 


